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What’s New in This Release

• Cisco Connection Online, page 43

• Caveat Index, page 47

Note For more recent release note information, check Cisco Connection
Online (CCO) for possible updates. Refer to the last section of this release
note for access information.

What’s New in This Release
• CiscoWorks Windows 3.1(1) supports

— Windows 95 and Windows NT 3.51 and 4.0.

Optionally, CiscoWorks Windows runs on

— Castle Rock SNMPc 4.1r and 4.2.04

— HP OpenView Professional Suite 7.2 (C.02.17) and 7.3 (D.01.00 and
D.01.02). (Formerly called HP OpenView Windows.)

Optionally on Windows NT 4.0, CiscoWorks Windows runs on

— HP OpenView Network Node Manager 5.0 and 5.01

• CiscoWorks Windows supports the following upgrade path:

— Upgrade from CiscoWorks Windows 2.x

• The number of MIB objects that can be queried has been increased from
512 to 2048.

• CiscoWorks Windows is Year 2000 Compliant.

• Some software defects in CiscoWorks Windows 3.0(1) have been fixed.

Caution Before installing CiscoWorks Windows or CiscoView devices,
read the caveats in “CiscoWorks Windows” on page 12.
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Cisco IOS Information

About Device Support
New devices are supported on all platforms unless otherwise noted. A
README file describing device support is included on Cisco Connection
Online (CCO).

Note For the latest device support packages, refer to Cisco Connection
Online (CCO).

To mount and install devices from the support CD, refer to the CD booklet
included in the package. Be sure to read theREADME files on CCO.

Cisco IOS Information
This section contains the latest Cisco IOS (Internetwork Operating System)
software version information at the time of printing.

Configuration Builder devices support Cisco IOS software Releases 10.2
through 11.2. Access servers require a minimum of Cisco IOS software
Release 10.3. Cisco 3600 devices require Cisco IOS software Release 11.1 or
later. Cisco 4000 series devices require Cisco IOS software Release 10.3 or
later.

CiscoView, Show Commands, and Health Monitor devices support Cisco IOS
software Releases 10.2 through 11.2.

Note CiscoView supports the Qualified Logical Link Control (QLLC)
feature in Cisco IOS software Release 10.3(7) or later and in Cisco IOS
software Release 11.0(2) or later. CiscoView supports the Synchronous Data
Link Control (SDLC) feature in Cisco IOS software Release 10.2 or later.
CiscoView supports the CIP card in Cisco IOS software Release 10.2 or later.
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Documentation Information

New devices and further specifics on Cisco IOS support will be updated as
devices become supported. For the online release notes, refer to one of the
following:

• Cisco Connection Online (CCO) in the Cisco Connection Documentation
section (continually updated)

• Cisco Connection Documentation, Enterprise Series CD

Note The Cisco Connection Documentation, Enterprise Series CD was
formerly called UniverCD.

Documentation Information
The documentation for CiscoWorks Windows includes this document, a
CD-ROM booklet, an overview manual, and online help. The primary
documentation for CiscoWorks Windows is the online help. If you have
documentation feedback, please forward comments to

bug-doc@cisco.com

You can also refer to the CiscoWorks Windows registration/reference card for
information on adding device support to CiscoView.

The documents shipped with this release include:

• Overview for CiscoWorks Windows

• CiscoWorks Windows CD Installation Instructions, which includes quick
reference instructions for downloading device packages.

• CiscoWorks Windows Release Notes

Customer documentation can also be found on the Cisco Enterprise Customer
Documentation CD or on CCO.
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CiscoWorks Windows Device Information

CiscoWorks Windows Device Information
Table 1 shows supported CiscoView devices by product type.

Table 1 Supported CiscoView Devices

Small to Medium
Business Products

Mid-Range Enterprise
Products 1

High-End Enterprise
Products

Cisco and CiscoPro 761,
762, 765, 766, 771, 772, 775,
776

Catalyst and CiscoPro switch
models2 1200, 1400, 1600,
1601, 1700, 1800, 1900, 2100,
2600, 2800, 2820, 2900, 2926,
3000, 3100, 3200, 3900, 5002,
and CPW2200

Catalyst 5000, 5500, and
5505

Cisco or CiscoPro 1003,
1004, and 1005

EtherSwitch Pro16,EPS2015,
1200, 1220, 1400, 1420

Cisco 7000, 7010, 7204,
7206, 7505, 7507, 7513
routers

Cisco and CiscoPro 1601,
1602, 1603, 1604, 1605

EtherSwitches: Pro16 and
CPW16

LS10103

Cisco 2501, 2502, 2503,
2504, 2505, 2507, 2509,
2510, 2511, 2512, 2513,
2514, 2515, 2516, 2520,
2521, 2522, 2523, 2524, and
2525

CiscoPro switch models
CPW10_100, CPW500,
CPW1200, CPW1220, and
CPW1400

CiscoPro 2051, 2052, 2503,
2504, 2505, 2507, 2509,
2511, 2513, 2514, 2516,
2520, 2521, 2522, 2523, and
2524

Workgroup concentrators
1400

Cisco and CiscoPro 3600
series (includes 3620 and
3640)

Fasthub 216T

Cisco and CiscoPro 4000
series4 (includes 4000,
4000-M, 4500, 4500-M,
4700, and 4700-M)

AS5200 Access Server AS2509-RJ
AS2511-RJ

AS5300 Access Server
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CiscoWorks Windows Device Information

Note Check the CCO periodically for download information on the latest
device support and upgrades.

Table 2 provides the CiscoWorks Windows applications and the devices each
application supports.

Cisco 1501, 1502, 1503,
1516

NetBeyond Fasthub 300 and
Fasthub 100+ Series

EPS-500, EPS-1500,
EPS2115, CPW-500,
CPW-2115, and CPW-16

1. Adapters WA-C301TA, WA-C303TA, WA-C308TA, WA-C306TA, WA-C321T-PC, WA-C321T-UX,
WA-C323T-PC, WA-C323T-UX, WA-C326T-PC, WAC326T-UX, WA-C328T-PC, WA-C328T-UX
are no longer supported.

2. Catalyst 1000 and 1100 are no longer supported.
3. LS100 and LS2020 are no longer supported.
4. Due to a fix made for the BRI port problem, the Cisco 4000 series devices now support Cisco IOS 10.3

or later.

Table 2 Supported CiscoWorks Windows Applications

Configuration Builder 1 Show Commands Health Monitor

Routers: 2500, 2501, 2502,
2503, 2509, 2510, 2511,
2514, 2512, 2515, 2520,
2521, 2522, 2523, 2524,
2525, 4000, 4500, 7000,
7010, 7204, 7206, 7505,
7507, and 7513

Routers: AccessPro,
2501-15, 4000, 4500,
7000, 7010, 7204, 7206,
7505, 7507, and 7513

Routers: AccessPro,
2501-15, 4000, 4500,
7000, 7010, 7204, 7206,
7505, 7507, and 7513

Hub/Router: 2505 and
2507

Hub/Router: 2505 and
2507

Hub/Router: 2505 and
2507

Table 1 Supported CiscoView Devices (Continued)

Small to Medium
Business Products

Mid-Range Enterprise
Products 1

High-End Enterprise
Products



CiscoWorks Windows 3.1(1) Release Notes  7

CiscoWorks Windows Device Information

Note Check the CCO periodically for download information on the latest
device support and upgrades.

Table 3 describes the applications supported by CiscoView.

Access Servers: 2509,
2510, 2511, and 2512

Access Servers: 2509,
2510, 2511, and 2512

CiscoPro switch models
CPW 10-100, CPW500,
CPW 1200, CPW1400, and
CPW2115

CiscoPro switch models
CPW 10-100, CPW500,
CPW 1200, CPW1400, and
CPW2115

1. Configuration Builder devices support Cisco IOS software Releases 10.0 through 11.2, with the
exception of access servers, which require a minimum of Cisco IOS software Release 10.2.
Cisco 3600 devices require Cisco IOS software Release 11.1 or later. Cisco 4000 series devices
require Cisco IOS software Release 10.3 or later.

Table 3 Supported CiscoView Applications

Application Description OS Cisco IOS Device Support

Threshold
Manager

Monitors the
availability and
performance of Cisco
devices

Windows 95,
Windows NT 3.51 and
4.0

Release 11.1 or 11.2
with RMON events
and alarms group
support

All devices with
appropriate
Cisco IOS or
RMON features

StackMaker Manages the device
membership in a
Cisco stack

Windows 95
Windows NT 3.51, 4.0

Releases 10.0 through
11.2

Cisco and CiscoPro
1600, 3600, 3620,
3640, Catalyst
1900, Catalyst
2820, CPW1220,
CPW1420, Fasthub
100+ and
NetBeyond Fasthub
300

Table 2 Supported CiscoWorks Windows Applications (Continued)

Configuration Builder 1 Show Commands Health Monitor
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CiscoWorks Windows Device Information

The CiscoView device packages included in this release are shown in Table 4.

Flash File
System

Provides file copying
and editing features
for Cisco 7000, 7010,
7204, 7206, 7505,
7507, and 7513
routers

Windows 95
Windows NT 3.51, 4.0

Releases 10.0 through
11.2

Cisco 7000, 7010,
7204, 7206, 7505,
7507, 7513 routers

Table 4 CiscoView Device Package Versions

Device Package Version

1000.pkg 4.0(1.2)

1500.pkg 4.0(1.2)

1600.pkg 4.0(4.2)

2500.pkg 4.0(3.1)

3600.pkg 4.0(6.1)

4000.pkg 4.0(2.4)

700.pkg 4.0(1.4)

7000.pkg 4.0(3.0)

AS5200.pkg 4.0(3.1)

AS5300.pkg 4.0(1.1)

CPW10_100.pkg 4.0(1.4)

CPW1200.pkg  4.0(1.4)

CPW1220.pkg 4.0(1.5)

CPW1400.pkg 4.0(1.4)

CPW1420.pkg 4.0(1.5)

CPW16.pkg 4.0(1.1)

CPW2115.pkg 4.0(1.1)

CPW2200.pkg 4.0(1.5)

CPW316.pkg 4.0(1.4)

Table 3 Supported CiscoView Applications (Continued)

Application Description OS Cisco IOS Device Support
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Incremental Installation Information

Incremental Installation Information
You can add new devices to CiscoView from CCO. For more information,
refer to the “Downloading Device Packages” chapter inOverview for
CiscoWorks Windows. Aquick reference version exists in theCiscoWorks
Windows CD Installation Instructions booklet. For our partner-initiated
customers, refer to the section “Partner Initiated Customer Accounts.”

CPW500.pkg 4.0(1.1)

Cat116.pkg 4.0(1.4)

Cat1200.pkg 4.0(1.4)

Cat1600.pkg 4.0(1.2)

Cat1700.pkg 4.0(1.4)

Cat1800.pkg 4.0(1.1)

Cat1900.pkg 4.0(1.6)

Cat2100.pkg 4.0(1.4)

Cat216.pkg 4.0(1.1)

Cat2600.pkg 4.0(1.2)

Cat2800.pkg 4.0(1.4)

Cat2820.pkg 4.0(1.5)

Cat2900.pkg 4.0(1.7)

Cat3000.pkg 4.0(1.6)

Cat3900.pkg 4.0(1.1)

Cat5000.pkg 4.0(1.8)

Cat5500.pkg 4.0(1.7)

Cisco1516.pkg 4.0(1.1)

EPS2015.pkg 4.0(1.1)

LS1010.pkg1 4.0(1.4)

1. Please upgrade to LS1010 device package version 4.0(1.8). This
package can be downloaded from CCO.

Table 4 CiscoView Device Package Versions (Continued)

Device Package Version
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Defects Fixed in This Release

Partner Initiated Customer Accounts
To get more information about the Partner Initiated Customer Accounts
(PICA) program before accessing CCO for device package files, use the
following URL:

http://www.cisco.com/acs/info/pica.html

You can also refer to the “Downloading Device Packages” chapter in
Overview for CiscoWorks Windows.

Defects Fixed in This Release
The following problems in CiscoWorks Windows 3.0(1) are fixed in
CiscoWorks Windows 3.1(1). Only the most serious problems are shown in
Table 5.

Table 5 Defects Fixed in CiscoWorks Windows 3.1(1)

CSCdi70385 Configuration Builder does not insert lines into access lists on router

CSCdi82266 CiscoView AS5200 package problem in SNMPc TrendWatch.

CSCdi86422 SNMPc Display MIB table not working for lifTable.

CSCdi87065 CiscoView 4.0 engine should not poll a device that is out of display in
Stack

CSCdj07135 10BaseT interface fails to select

CSCdj07710 Unable to configure Catalyst 5000 port

CSCdj12860 SanFran:Etna module reports error messages while getting displayed

CSCdj14942 CiscoView: 5111 and 5011 cards don’t have link ports

CSCdj15629 CiscoView engine crashed due to continuously polling large table

CSCdj15790 7000 symbol registered for 7010 router in oid_to_sym

CSCdj17659 Cannot set Token Ring segment on Catalyst 1600

CSCdj18660 LS1010:LEDs on IBIS PAM not labeled

CSCdj26323 Fractional interfaces are displayed for one port only

CSCdj28590 ATM interface stats to be computed based on frames, not octets

CSCdj30092 Cannot modify VLAN number in port config for Catalyst 5000

CSCdj32207 Config Builder cannot configure 8-port ISDN on 7XXX

CSCdj56651 CWW 3.0 locks OV MIB Database
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Troubleshooting

Troubleshooting
If you cannot open a device in CiscoView, you receive a message that the
device is unmanageable for one of the following reasons:

• The Simple Network Management Protocol (SNMP) agent is not running
in the device.

You can still ping the device from the management station.

• You have entered an incorrect community string in the File>Open Device
window.

• The management station cannot reach or successfully ping the device.

• You have the wrong device package version.

Check your device package and compare the date with the version on
CCO. Upgrade to the latest version, if required.

CiscoWorks Windows Notes and Caveats
This section contains notes and restrictions that apply to the CiscoWorks
Windows 3.1(1) release.

• Installation Notes and Caveats, page 12

• General Notes and Caveats, page 14

Note For your reference, identification numbers follow the description of
the caveat, for example, [CSCdj00001]. If you need to contact Technical
Support about one of the following caveats, refer to the identification number
to speed up the resolution of any questions or situations you might encounter.
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CiscoWorks Windows Notes and Caveats

Installation Notes and Caveats
Installation notes and caveats for CiscoWorks Windows follow.

Castle Rock SNMPc
• For the bug fixes in SNMPc 4.1r/4.2.04, refer to the SNMPc readme file.

Use the following URL to access the Castle Rock SNMPc 4.2.04 release:
http://www.castlerock.com/update.htm.

If you plan to upgrade from 4.1r to 4.2.04, do so before installing
CiscoWorks Windows 3.1(1). Otherwise you will need to reinstall
CiscoWorks Windows 3.1(1) after upgrading to SNMPc 4.2.04.

• After a new SNMPc installation, you will need to reinstall CiscoWorks
Windows.

• When you run CiscoWorks Windows on SNMPc for the first time, you are
prompted to compile MIB files. Select theYesbutton. If you do not
compile the MIB files, SNMPc might not properly discover and manage
your Cisco devices, and CiscoWorks Windows applications might not
execute properly. MIB compilation might issue warning messages.

• Autodiscovery finds SNMP devices as ping nodes or finds nothing after
clearing the discovery log. Verify that the read community string is
correct. Start autodiscovery again to see if the problem persists. If it does,
terminate autodiscovery and restart from the SNMPc Map menu.
[CSCdi40648]

CiscoWorks Windows
• Shut down all applications before installing CiscoWorks Windows.

CiscoWorks Windows installation might overwrite old Windows dynamic
link libraries (DLLs) with newer versions, which could active applications
to terminate.

• If the Kalpana SwitchVision application is installed on your system,
uninstall the product before proceeding with the CiscoWorks Windows
install.

• If CiscoWorks Windows fails to run immediately after an initial
installation, exit and restart Windows.
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CiscoWorks Windows Notes and Caveats

• Do not install CiscoWorks Windows and CiscoVision on the same
workstation. This configuration is not currently supported, and results are
unpredictable.

• CiscoWorks for Switched Internetworks (CWSI) 1.2 and CiscoWorks
Windows 3.1 cannot coexist on the same machine. To upgrade CWSI 1.2
to CiscoWorks Windows 3.1, perform the following steps:

(a) Remove VlanDirector by selecting Uninstall VlanDirector in the
CiscoWorks Windows program group.

(b) Remove CiscoWorks Windows by selecting Uninstall CiscoWorks
in the CiscoWorks Windows program group.

(c) Install CiscoWorks Windows. For details, refer to theCiscoWorks
Windows CD Installation Instructions document.

Uninstalling only CiscoWorks Windows will remove the VlanDirector
files but not information in the registry.

Delay When Installing All Devices
If you select all the devices to be installed from the Device Install menu, it
might take some time before there is an indication that the installation is
progressing.

Uninstalling the Network Management Platform
If the network management platform with which CiscoWorks Windows is
integrated (for example, SNMPc 4.2.04) is uninstalled, CiscoWorks Windows
behavior will be unstable. To work around this problem, uninstall
CiscoWorks Windows before uninstalling the network management platform,
then reinstall CiscoWorks Windows. [CSCdj40831]
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CiscoWorks Windows Notes and Caveats

Hardware Disk Space Requirements
• The hardware disk space requirement for CiscoWorks Windows is 90 MB

of free disk space with all packages installed. Additional disk space is
needed for the NMS. Approximations follow. Consult the documentation
that accompanies the NMS product for specific disk space requirements.

• For Windows NT 4.0 Server, the disk space requirements are typically
double that of the other supported platforms, assuming that
Windows NT 4.0 was installed with the default allocation unit size of
65536 bytes. This results in a requirement for 438 MB of available hard
disk space during installation. After installation, 100 to 180 MB of hard
drive space is required, depending on the number of devices you install.

Windows NT
• CiscoWorks Windows 3.1(1) has not been tested on a system on which

Optivity resides. [CSCdi57009]

General Notes and Caveats
General notes and caveats are divided into six sections:

• Notes and Caveats for Operating Systems and Other NMS, page 15

• Notes and Caveats for Enterprise Network Management Products
(CiscoView, Configuration Builder, Health Monitor, StackMaker, Show
Commands, and Threshold Manager), page 18

• Notes and Caveats for Workgroup Products, page 24

• Notes and Caveats for Access Products, page 33

NMS Version
Approximate Disk Space
Required (MB)

HP OpenView Professional Suite 7.3 D.01.02 28

HP OpenView Network Node
Manager for Windows NT

5.01 55

SNMPc 4.2.04 8
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CiscoWorks Windows Notes and Caveats

• Notes and Caveats for High-End Business Products (ATM switches and
the Cisco 7000, 7200, and 7500 series), page 39

• Notes and Caveats for Online Help, page 42

Notes and Caveats for Operating Systems and Other NMS
General notes and caveats for CiscoWorks Windows operating systems and
optional Network Management Systems follow.

Castle Rock SNMPc

Changing the Device Community String for SNMPc
You can change the default device community string only once in Castle Rock
SNMPc, by using theEdit>Node Defaultscommand. You then need to save
and reload the network map for the new default community string to take
effect. Performing this procedure again has no effect. You can use the
following workaround to change community strings in the future.

You can change the community strings for all devices at once, instead of one
at a time.

Step 1 Select one node.

Step 2 SelectEdit>Edit Object .

Step 3 SelectComm...

Step 4 Change to the appropriate community string.

Step 5 SelectChange in the Edit Node Attributes window.

Step 6 SelectEdit>Copy.

Step 7 SelectMap>Select Nodes.

Step 8 SelectAll Agent Types and Entire Map.

Step 9 SelectEdit>Paste.

Step 10 Make sure only Community and In Map are selected, then click
OK .

This procedure sets the community string for all selected objects.
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CiscoWorks Windows Notes and Caveats

Debug SNMP Menu Option
When the SNMP Debug option is enabled, it pops up a separate console
window that shows SNMP traffic to and from the device. Do not close this
window because CiscoView will exit also.

SNMPc Error Messages
Use the following recommended actions for dealing with error messages:

• If you receive the following message

Unknown Node name

when you double-click on an icon, exit and restart SNMPc. [CSCdi40732]

• If you receive the error message:

WinSNMP Could not runC:CV4NTtrapx.exe [No TRAPs or IPX!]

when you restart CiscoWorks Windows or SNMPc immediately after
exiting a previous session, wait at least 20 seconds before restarting
CiscoWorks Windows and SNMPc. [CSCdi40713]

• If you receive warning messages during SNMPc MIB compilation, you
can ignore them. [CSCdj47036]

Refer to theSNMPc Network Management Reference Guide for more
information about running CiscoWorks Windows/SNMPc.

HP OpenView Network Node Manager Version 5.0 and 5.01 on Windows NT
• Before installing CiscoWorks Windows, stop the netmon by running the

commandovstop netmon. CiscoWorks Windows installation might be
delayed if netmon is running when you launch the install. After
CiscoWorks Windows installation, netmon will be started automatically if
CiscoWorks Windows was chosen to be integrated with Network Node
Manager. If you are not integrating CiscoWorks Windows with Network
Node Manager, start netmon by running the commandovstart netmon.

• Traps defined in the MIBBRIDGE-MIB.my are not loaded into
HP OpenView Network Node Manager. Because of this, HP OpenView
Network Node Manager does not recognize the traps newRoot and
topologyChange. [CSCdj62552]
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CiscoWorks Windows Notes and Caveats

• When CiscoView 4.1 is integrated with HP OpenView Network Node
Manager Version 5.0 and 5.01 on Windows NT, only generic Cisco router
icons appear for some devices. [CSCdj41196]

• Network Node Manager terminates abnormally when you right-click an
added Cisco device object after the corresponding package has been
uninstalled. This does not happen for objects in the map discovered by
Network Node Manager. To work around this problem, delete any added
object before uninstalling the corresponding package [CSCdj60849].

HP OpenView Professional Suite
CiscoWorks Windows does not integrate traps with HP OpenView
Professional Suite (HP OpenView Windows). [CSCdj12760]

Windows 95
Because of IPC (socket) problems in the TCL version used by CiscoView 4.1
on the Windows 95 operating system, the following features do not work
properly and have been disabled:

• CV reuse window feature available in the Options>Properties menu
[CSCdi84212]

• Domain Configuration and Etherchannel Configuration applications
[CSCdj02042]

On Windows 95, different colors appear in Grapher as port status is reset. You
can refresh or redisplay the window as a workaround. [CSCdi53523]

CiscoWorks Windows 3.1(1) cannot be installed on Windows 95 if FPROTO
2.2.7 is also installed and active on the machine. Deactivate FPROTO 2.2.7
before you install CiscoWorks Windows 3.1(1) [CSCdj38627].

Windows NT
Under the Windows NT environment, running too many sessions of the
CiscoWorks Windows applications (Health Monitor, Show Commands, and
Configuration Builder) simultaneously can cause a General Protection Fault
(GPF) in the moduleMFC250.dll. This is a known Microsoft bug that you can
avoid by running fewer sessions of the applications. [CSCdi31282,
CSCdi34536]
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CiscoWorks Windows Notes and Caveats

Notes and Caveats for Enterprise Network Management Products

Colormap Problems
Windows 95 has a known Microsoft colormap problem. Some colors are
mapped incorrectly when you switch between applications.

Community String Mismatching
When you enter values for the read-only, write-only, and read-writeId with
the Command Line Interface (CLI) commands, these values must match. A
mismatch results in noSuchName or timeout errors. To avoid these errors, use
identical community strings in CiscoView and corresponding agents.

Dragging Ports
For this release, use the left mouse button to drag a port on Windows. Only
certain devices (such as the CAT1200, CAT1600, CAT5000, CPW16) have
defined their ports for dragging across devices.

IP Address
The Health Monitor, CiscoView, Show Commands, and Configuration
Builder applications communicate with a device using its primary IP address.
If the primary interface is down, these applications can not locate or reach the
secondary IP address for that device. [CSCdi31320]

Popup Menu Titles
Popup menu titles are raised; users can mistake them for menu items.
[CSCdi53475]

Starting CiscoView on Device Interfaces
If you start CiscoView on an expanded node’s interface icon (for example,
example.cisco.com:1), you will not be able to Telnet to that device—Telnet
tries to use port 1. Do not start CiscoView on device interfaces. [CSCdi56385]
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CiscoWorks Windows Notes and Caveats

Stripchart and Dials
Stripchart and dials are not refreshed properly. This is especially true for
Windows 95. [CSCdi51621]

TACACS
If you have TACACS or login security enabled on your router, the Show
Commands application and the Configuration Builder Learn and Send
features will not function. However, you can send configuration files
generated by Configuration Builder using standard TFTP.
[CSCdi31004][CSCdi76685]

CiscoView

Launching CiscoView
On some systems running Windows, launching CiscoView for the first time
might take longer than a minute. [CSCdj52543]

Unable to Display FEIP-FX Card
The FEIP-FX card does not appear in CiscoView. When the Cisco 7000 series
device comes up, you might see the error message “no such element in array.”
[CSCdj61077]

Config/Monitor for Multiple Ports
For some devices, config/monitor does not work for multiple ports.
[CSCdj65066]

CiscoView and Internationalization
CiscoView does not support internationalization.
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CiscoWorks Windows Notes and Caveats

CiscoView Times Out
In high traffic situations, you might experience timeouts. To increase the
timeout period, selectOptions>Properties from the CiscoView menu and
change the value for the Timeout field.

You should not reduce the physical view polling interval below
(retries*timeout), especially if you experience timeouts; this can exhaust
resources on Windows and result in a general error.

CiscoView Windows 95 Exception
When running CiscoView 4.1 on Windows 95, you might experience the
following exception. If you experience this, exit all other running applications
and run CiscoView as a standalone application. This crash has been observed
while running Heat v 3.10 from Bendata Inc.

WISH caused an invalid page fault in
module KERNEL32.DLL at 014f:bff78040.
Registers:
EAX=00465504 CS=014f EIP=bff78040 EFLGS=00010206
EBX=005553f4 SS=0157 ESP=0068e994 EBP=00000466
ECX=00100000 DS=0157 ESI=00465504 FS=293f
EDX=0046000c ES=0157 EDI=000efef0 GS=20d6
Bytes at CS:EIP:
8b 03 a8 01 74 25 25 fc ff ff 0f 8b 53 08 03 f8
Stack dump:
00000466 000efef0 004653f4 00000110 bff782c7 00460000 00465504
000efef0

00000000 004653f4 00460000 00000041 0046000c 00000555 00000000
00000040

[CSCdj46680]

Configuration Builder

Access Server Dialog Boxes
For access server dialog boxes, the cursor will not provide feedback for
incorrect data entry in fields, nor is the field with incorrect data highlighted.
Font resizing at various screen resolutions might cause the incorrect sizing of
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CiscoWorks Windows Notes and Caveats

text or limit the visible selections in pull-down combo-boxes. You can select
invisible combo-box selections by holding down the right mouse button while
in the combo-box, then scrolling up or down. [CSCdi34066]

Access Server Features
For access server features, the Chat Script Manager dialog box might create

expect null/send null lines

in a chat script. If you inadvertently create empty lines under the Expect and
Send fields, you receive error messages about your chat script. Delete and
recreate the chat script. [CSCdi34038]

Context-Sensitive Help
Selecting a menu item with the mouse and pressingF1 opens the
Configuration Builder Help Contents main window instead of
context-sensitive help. However, context-sensitive help is supported for all
Configuration Builder dialog boxes. [CSCdi34304]

Dialog Box Margins
Dialog box margins might not align on some monitor resolutions. [3D-look]

Invalid OS Error
On Windows NT, if an incorrect model is selected in the Model field of the
New Configuration File dialog or the Cisco IOS field is empty or incorrectly
filled in, you might encounter the following error message “Invalid OS
Specified. OS version should be greater than 10.2.”

The workaround is to enter the device’s correct Cisco IOS version number
into the Cisco IOS field. This Cisco IOS version should be greater than 10.2.
[CSCdj12523]

Sending Configuration Files
Configuration Builder is designed for initial configuration and subsequent
modifications of routers. A configuration sent by Configuration Builder might
not completely overwrite a manually created or modified existing
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configuration. To simplify configuration, Configuration Builder supports the
most common configuration options and uses defaults when possible. You are
encouraged to view configurations before sending them to a router to ensure
that the generated configuration commands and defaults meet your
expectations.

If you receive a banner command timeout error message when sending a
configuration file, remove the banner command from the configuration file
and resend the file. If you receive other command timeout error messages
when sending files, selectFile>Communication Timeouts. In the
Communication Timeouts dialog box, increase the long and short timeout
values and try sending the file again. [CSCdi20708]

Spreadsheet Control
• If you use theF1 key often while the input focus is within a dialog box,

Configuration Builder spreadsheet controls can lose track of certain
pointers. To release memory and refresh the pointers, log out of Windows
and log in again. [CSCdi34671]

• When you use the keyboard to navigate spreadsheet style controls, you
must press the space bar twice to modify a check box. [CSCdi15204]

• TheEsc key does not close the window when the input focus is in the
spreadsheet style controls. Use the window menu or move the input focus
out of the spreadsheet controls to close the window. [CSCdi15891]

Health Monitor
• TheF1 key context-sensitive help feature is not supported for Health

Monitor menu items. Context-sensitive help is supported for all Health
Monitor dialog boxes. [CSCdi32448]

• To see the most recently polled data, click the right scroll bar.
[CSCdi70842]
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Show Commands
Show Commands features are not supported by all device types. However,
Show Commands’ unsupported features can still be selected.

If you select an unsupported feature, you see an error message. For example,
if you select the show controllers CxBus feature for a Cisco CPA2509, you
see the following error message:

This command is not supported by this IOS image.

[CSCdi30902]

StackMaker

Internal Debugging
When the StackMaker Debug option is set toOn, debug messages print to the
StackMaker Debug Log file. The default isOff . The StackMaker Debug Log
file stores messages that are useful in troubleshooting problems. This log file
is smDebugLog in c:\CWW or the install directory.

When the StackMaker Debug SNMP option is set toOn, SNMP debug
messages print to the console on the PC. The messages show the SNMP
packets that have been sent and received. The default isOff .

Log File from Apply Operations
The StackMaker log file stores the results of a saved stack configuration
(Actions>Apply Stack Configuration). The log file is
$NMSROOT\etc\cview\devices\stackmkr\sm.log. When the log file exceeds
1 MB, it automatically resets to 0 bytes.

Threshold Manager

Threshold Settings
Some agents, most notably the Catalyst switches, impose a limit on the
number of alarm and event entries that can be created. Applying a large
number of thresholds to these devices will likely fail. In this case, some alarm
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entries might be successfully created but their associated event entries are not.
These failed creations are marked asFailed in the Current Threshold Settings
pane. If you attempt to delete those settings, Threshold Manager reports that
the deletion failed (because it cannot delete nonexistent event entries). In this
case, you can ignore the error message, and can verify that the deletion
occurred by retrieving the threshold settings after the deletion.

Policies
New policies are always added to the display list.To view the new policies,
exit the Configure Thresholds window, then reopen it. [CSCdi62741]

Policy filenames do not match if the IP address is used. To correct this, use
the host name instead of the IP address when saving host-specific policies.
[CSCdi62739]

Duplicate global/device/host policies may be allowed, depending on which
window is used. When creating a custom policy, you can save it only once,
either as global, device, or host. But after saving the policy, you can use the
Modify Threshold Policy window to modify the saved custom policy and save
it as all three. [CSCdi68329]

Notes and Caveats for Workgroup Products

Catalyst 1900, Catalyst 2820, CPW 1220, and CPW 1420
To delete an entry from the Set Managers configuration, enter an IP address
of 0.0.0.0. The agent on the devices do not accept a blank entry for an IP
address. [CSCdj03444]

Catalyst 116 and CPW 316
To delete an entry from the Set Managers configuration, enter a blank field.
The IP address of 0.0.0.0 does not remove the entry from the Set Manager
Table.
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Catalyst 216
The Cat216 4.0(1.1) device package will not work in HP OpenView
Professional Suite 7.2 (C.02.17) and 7.3 (D.01.00 and D.01.02) because of an
invalid HP OpenView device ID.

Catalyst 1200
When you use the Switch Zoom menu (if TrafficDirector is installed) from
CiscoView to view multiple switch ports, the default configuration for the
Catalyst 1200 is to configure Statistics, Short-Term history, Long-Term
history, and Host group. To see the Short-Term or Long-Term history from
Traffic Monitor, use the Domain Manager to configure the Short-Term and
Long-Term groups manually or use Segment Zoom to view the port first.

When you use the Segment Zoom menu from CiscoView to view the port
segment, the default configuration for the Catalyst 1200 is to configure the
Statistics, Short-Term history, Long-Term history and Host group. For the
Catalyst 5000 it is Statistics, Short-Term history, and Long-Term history.

If you see the message “Error: Entry or Group not present in Agent” when
invoking Segment Zoom, Switch Zoom, or Data Capture, the write
community string might not be matched with the device. If the community
string is matched and the problem still occurs, use the CiscoView Configure
Device menu to see whether the RMON capability is enabled.

If you launch Switch/Port Zoom from CiscoView and then delete one of the
RMON agents using TrafficDirector, you must relaunch CiscoView before
launching Switch/Port Zoom again.

If you see the message “IP address is not set in sysIpAddr Mib variable,” it is
because the Catalyst 1200 SNMP agent did not store the correct IP address in
the sysIpAddr MIB variable. You must use CiscoView to correct it. Select
Configure>Device, enter the correct IP address in the corresponding field,
and clickModify .

TrafficDirector 3.3 cannot be launched for interfaces with ifIndex values
greater than 1000.
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Catalyst 1800
The device agent does not update the IP address table of MIB-II properly and
does not reflect the correct IP address information of all the device interfaces.
You cannot view the correct IP Address information of the device by selecting
Device>Configure>IP Address Table.

You cannot create new static entries for IP Route Table and ARP Table
through CiscoView.

In the interface configuration (Port>Config>Interface), modifying the IP
parameters always displays ian error message, but the modification is
successful.

You cannot change the bridge type of the FDDI port to sr-only or srt.

You cannot change the bridge type of the Token Ring port to srtb or tb-only.

The system time configuration is not included as part of device configuration.

Catalyst 1900, Catalyst 2100, Catalyst 2800, EtherSwitch 1200, and
EtherSwitch 1400 Series Devices
CPW1200, CPW1220, CPW1400, CPW1420, Catalyst 1900, Catalyst 2100,
Catalyst 2800, and Catalyst 2820—The General Bridge window shows the
bridge information for VLAN1 only. Bridge information for other VLANs is
not available.

CPW1220, CPW1420, Catalyst 1900, and Catalyst 2820—In the CDP
Configuration Dialog, changing the transmission time of one port changes the
transmission time of all ports. This is a feature of the implementation of the
corresponding MIB objects in the device firmware. [CSCdi83959]

CPW1200, CPW1220, CPW1400, CPW1420, Catalyst 1900, Catalyst 2100,
Catalyst 2800, and Catalyst 2820—The Spanning Tree Protocol Window for
switched ports is available for ports in VLAN1 only. This window does not
show valid information for ports not in VLAN1.

CPW 1420 and Catalyst 2820
On the front panel display of the device, the Connect and Disabled LEDs on
FDDI modules do not reflect the appropriate status.

Although a Monitor menu option is available for both FDDI and repeater
ports, this feature is not supported on these modules. [CSCdj57452]
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TheConfigure>Module option is supported for only one module type, even
though it can be invoked for multiple module types.

There is a dependency between the CPW1420 and Cat2820. The CPW1420
device package will not run unless the Cat2820 package is installed.
[CSCdj64496].

Catalyst 2600
The Catalyst 2600 device package contains two versions of the enterprise
MIBs for the Catalyst 2600 switch:

• C2600_cisco.my—This MIB file is installed to support devices with
image versions prior to 2.2.1.

• C2600.my —This MIB file is installed to support devices with image
version 2.2.1 or later.

If you are using a MIB browser tool, you will see the MIB variables defined
in each of the files above, under different branches, at the same time, although
any particular Catalyst 2600 switch will respond to queries on only one of the
MIBs, based upon the release of software in the device. Cisco recommends
that you upgrade your Catalyst 2600 switches to version 2.2.1 or later.

CPW 2200 and Catalyst 2900
Under a heavy load condition, SNMP responses are slow. You might see an
“error, no response since....” message in the CiscoView status window. Select
Options>Propertiesand increase the Polling Frequency and Timeout values.
[CSCdi57962]

If the number of the embedded RMON agent is over 50, you cannot create any
new embedded RMON agent groups for the new port. Use the Domain
Manager to uninstall the agent group from the unused port to free the memory
resource.

If you launch Switch/Port Zoom (if TrafficDirector is installed) from
CiscoView and then delete one of the RMON Agents using TrafficDirector,
you must relaunch CiscoView before launching Switch/Port Zoom again.

TrafficDirector 3.3 cannot be launched for interfaces with ifIndex values
greater than 1000.
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When multiple ports are selected, the Port>Configure window does not
display the Broadcast Suppression category. This category is available only
for single port selection.

When you enable port security administration on a port, there might be
timeouts. If this happens, increase the SNMP timeout value to approximately
10 seconds.

The WS-X2901 module shows the speed LED lit only when the speed is
configured as 100 Mbps and the port is connected.

The Port Utilization tool has been removed from the Tools menu and is now
available only on a per module basis on the Config>Module menu.

Catalyst 3000 Series
When you install CiscoView 4.1 and integrate it with HP OpenView 4.1.1,
you will see an error relating to theC3_2_0.myMIB file display. This error is
because of duplicate definitions in the Catalyst 3000 MIB files. To correct this
problem, download a new copy of theC3_2_0.my MIB andREADME files
from CCO at the following location:
ftp://www.cisco.com/cisco/netmgmt/ciscoview/temp-smu/
CSCdj03981.READMEandCSCdj03981.tar.Z[CSCdi03981]

When you access a stack with six or more devices, there might be some
significant performance problems. You can improve the performance by
increasing the SNMP timeout settings.

The Catalyst 3000 software does not support RMON on either a stack or an
ATM port.

You might notice timeout messages and SNMP Set Failed messages when
using the EtherChannel Configuration tool. If this happens, increase the
SNMP timeout values for better performance.

If you are running version 2.0(1) of the Catalyst 3000 software, you will not
be able to drag a port to a VLAN that does not already have ports assigned to
it. You can fix this problem by upgrading to a later release of Catalyst 3000
software.

If you are running version 2.0(1) of the Catalyst 3000 software, changes to
Full/Half Duplex settings will not always be reported correctly. You can fix
this problem by upgrading to a later release of Catalyst 3000 software.
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If you are running version 2.0(1) of the Catalyst 3000 software, the SAID
value entered when creating a new VLAN will be redisplayed as a different
value. However, the VLAN will have been created with the SAID value you
specified. You can fix this problem by upgrading to a later release of Catalyst
3000 software.

The Domain Configuration and EtherChannel Configuration tools are not
supported on Windows 95.

Because of to restrictions in the Catalyst 3000 software, the WS-X3006B is
displayed in CiscoView as a WS-X3006A.

If you launch Switch/Port Zoom from CiscoView (if TrafficDirector is
installed) and then delete one of the RMON Agents using TrafficDirector, you
must relaunch CiscoView before attempting to launch Switch/Port Zoom
again. TrafficDirector works only if CWSI is installed.

Catalyst 3900
CiscoView does not show the rear view of the Catalyst 3900 box.

When you attempt to drag port(s) to drop into one of the CRFs in the VLAN
table, CiscoView might exit with an error. To work around this problem, first
select the ports of interest, then bring the focus back to the VLAN Table
window, and then drag the selected port(s) and drop them into the desired
CRF.

TheConfigure...option under the Bridge Configuration category allows you
to view a current configuration only. It reports an error when you attempt to
configure new values for any parameter.

The Threshold Manager and TrafficDirector applications have not been fully
tested with the Catalyst 3900.

Catalyst 5000 Series
While integrating some device packages with HP OpenView Network Node
Manager, some Catalyst 5000 device-specific traps are not integrated into HP
OpenView. [CSCdj63184]
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After an online insertion/removal (OIR) event (also called a “hot-swap”),
CiscoView does not show the correct module or port status. The only way to
display the correct status is to reopen the device or relaunch CiscoView.
[CSCdj39860]

ATM, FDDI, and CDDI do not support Broadcast Suppression.

In machines that do not have a/tftpboot directory (such as a PC), an error is
displayed whenever the Upload/Download feature is invoked on a Catalyst
5000 module.

Do not use the Grapher in the CiscoView Monitor 10BaseT Group Switching
Ethernet window. Use the Monitor or TrafficDirector tools (if TrafficDirector
is installed) to see graphical views of the selected repeater ports.

When you use the Switch Zoom menu (if TrafficDirector is installed) from
CiscoView to view multiple switch ports, the default configuration for the
Catalyst 5000 is to configure Statistics only. To see the Short-Term or
Long-Term history from Traffic Monitor, use the Domain Manager to
configure the Short-Term and Long-Term groups manually or use Segment
Zoom to view the port first.

When you use the Segment Zoom menu from CiscoView to view the port
segment, the default configuration for the Catalyst 5000 is Statistics,
Short-Term history, and Long-Term history.

If you see the “Error: Entry or Group not present in Agent” message when
invoking Segment Zoom, Switch Zoom, or Data Capture, the write
community string might not be matched with the device. If the community
string is matched and the problem still occurs, use the CiscoView Configure
Device menu to see whether the RMON capability is enabled.

When you select the repeater module port on a Catalyst 5000, it always uses
the first port of the selected segment to create the RMON agent group.

If all Catalyst 5500 slots are populated with modules and you experience
timeouts, increase the SNMP timeout value to 15 seconds.

The WS-X5213 and WS-X5213A modules show the 100 Mbps speed LED lit
only if the speed is configured at 100 Mbps and the port is connected.

Opening the FDDI/Ethernet Bridge category under Configure>Device can
display “unknown error.” This is because of a problem with the device
software.
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If a general error (genErr) is displayed when you change vlanPortIslStatus,
the selected port might not support ISL.

The values of ifAdminStatus and ifLinkUpDownTrapEnable cannot be
changed on an ATM port.

Port duplex settings cannot be changed on ATM and FDDI ports.

The value of portSpanTreeFastStart cannot be changed on ATM and FDDI
ports.

Configuring ports to unsupported speeds returns a general error (genErr).
This is because of a problem in the device software.

The following list details the availability of Broadcast Suppression in terms
of pps (packets per second) or % (percentage) for modules on Catalyst 5000
series switches. A plus sign (+) means available, while a minus sign (-) means
not. Modules not on this list do not have Broadcast Suppression. The
Broadcast Suppression feature is not available on ATM and FDDI.
[CSCdi90909]

Module
Packets per
Second (pps) Percentage Note

WS-X5013 + +

WS-X5011 + -

WS-X5010 + +
% available with newer
hardware only

WS-X5113 + -

WS-X5111 + -

WS-X5213 + -

WS-X5020 + -

WS-X5114 + -

WS-X5223 + +

WS-X5224 + +

WS-X5213A + -



32 CiscoWorks Windows 3.1(1) Release Notes

CiscoWorks Windows Notes and Caveats

Fasthub 100+ and 300 Series
For devices that have an expansion module, the port numbering is not
consistent with the management console. Ports 17 through 32 are listed in
CiscoView as Repeater 2: Port 1 through 16. [CSCdi77159]

After the first reset of the device, you must set the rptrReset MIB variable to
noReset (default value) before the next reset can be performed. This is
because of to a problem on the device software and will be fixed in a later
release. [CSCdi77452]

CDP and CGMP Protocols Unsupported
The CPW 1200/1400 and Cat 2100/2800 devices do not support the CDP and
CGMP protocols. The CiscoView dialogs for these return errors.

Community String Mismatching
When you enter values for the read-only, write-only, and read-writeId with
the Command Line Interface (CLI) commands, these values must match. A
mismatch results in noSuchName or timeout errors. To avoid these errors, use
identical community strings in CiscoView and corresponding agents.

Dragging Ports
For this release, use the middle mouse button to drag on a PC. Only Catalyst
devices (such as the CAT1200, CAT1600, CAT5000, CPW16) have defined
their ports for dragging across devices.

Duplicate Categories
When multiple ports of different types are selected, Port>Config might show
duplicate categories.

Switch Firmware
The following firmware versions must be used in the switches:

• Catalyst 2100 and 2800—v. 3.63 or higher

• EtherSwitch 1200 and 2800—v. 3.63 or higher
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• EtherSwitch 10/100—v. 1.38 or higher

• Catalyst 1700—v. 1.38 or higher

• Grand Junction FastSwitch 10/100—v. 1.37 or higher

• Grand Junction FastSwitch 2100 and 2800—v. 3.62 or higher

Note The Grand Junction FastSwitch 2100 and 2800 are managed the same
as the Catalyst 2100 and 2800, respectively.

Switches
If you configure EtherChannel or Virtual Domains in Kalpana switch models
EPS2015RS, EPS2115RSM, and Pro16 while running version 9.0 firmware
with STP active, the map icons become red, and you receive the following
error message:

No response from the device

After restarting the system, deactivate STP before you reconfigure. This
problem is fixed in version 9.1 of the device firmware. [CSCdi41317]

Notes and Caveats for Access Products

Card Support for Cisco AS5300 Universal Access Servers
The following network processor modules are supported:

• as5300-4ct1

• as5300-4ce1

• pm-as5200-12m

• pm-dtd-6m
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Card Support for Cisco AS5200 Universal Access Servers
The following network processor modules are supported:

• as5200-carrier(290)

• as5200-2ctl(291)

• as5200-2ce1(292)

• pm-as5200-12m(310)

• pm-as5200-12m-56k(311)

• pm-as5200-12m-v110(312)

DS1 Line Channelized Info Not Displayed
A Cisco IOS defect causes CiscoView to not display the DS1 Line
Channelized info when a T1/E1 port is configured for cas-group. This is
applicable when the option is selected from the global menu item Connection
Info or if it is selected through the Line_ds1 config dialog box. [CSCdj44707]

Status of T1/E1 Channel_ports for Channel-group
In the channel_modem view, CiscoView does not properly reflect the status
of the T1/E1 channel_ports (timeslots) that have been configured for
channel-group. This is a Cisco IOS software problem.

Card Support for Cisco 1600 Series Routers
The following WAN interface cards are supported:

• wic-csu-dsu-4

• wic-serial-1t

• wic-s-t-2186

• wic-s-t-2186-leased

• wic-u-2091
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Card Support for 3600 Series Routers
The following WAN interface cards are supported:

• wic-1t

• wic-1dsu-56k4

• wic-1b-s/t

• wic-1b-s/t-ll

• wic-1b-u

The following network modules are supporrted:

• nm-4t

• nm-compr

• nm-1e2w

• nm-2e2w

• nm-1e1r2w

• nm-1ct1-csu

• nm-2ct1-csu

• nm-1ct1

• nm-2ct1

• nm-1ce1b

• nm-2ce1b

• nm-1ce1u

• nm-2ce1u

• nm-4b-u

• nm-4b-s/t

• nm-8b-u

• nm-8b-s/t

• nm-4a/s

• nm-8a/s
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• nm-4e

• nm-1e

• nm-4e

• nm-16a

• nm-32a

• nm-1fe-tx

• nm-1fe-fx

• nm-2v

• nm-1v

• vic-2em

• vic-2fxs

• vic-2fxo

• nm-6dm

• nm-12dm

• nm-18dm

• nm-24dm

• nm-30dm

BRI Interface Information is not Correct
For the BRI interface in 8-port BRI cards or 4-port BRI card, the configure
and monitor information shown in CiscoView is not correct. The information
does not correspond to the correct BRI interface. This problem is present only
if you use Cisco IOS Release 11.2 and above. This is a Cisco IOS software
defect, CSCdj50307.
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Hot Swap Does Not Work for Stacked Cisco 3600
The hot swap feature is not available for stacked Cisco 3600 series routers.

Whenever the async/sync port configuration is changed, you must reopen the
stack for CiscoView to update the async/sync port status. However, the hot
swap feature for the async/sync ports is supported for individual Cisco 3600
series routers.

Also, whenever the async/sync port configuration is changed in a 16/32 port
asynchronous network module, you must reopen the stack to obtain the latest
state. However, the hot swap feature for the async/sync ports is supported for
individual Cisco 3600 series routers.

Logical View and Channel Modem View Not Available in Stack View
The Logical view and Channel Modem Mapping view are not available for
stacked Cisco 3600 series routers. This support is scheduled for a future
release. However, for individual Cisco 3600 routers, Logical View is available
if a digital modem carrier card is present, and Channel Modem View is
available if a CT1/CE1 card is present.

Fix for CSCdi69480 Invalid for Cisco IOS Versions Below 11.1(7)
The fix for defect CSCdi69480 (PRI/E1 interfaces missing in cardIfIndex
table) is integrated into Cisco IOS Release 011.001(007) and above. The
Cisco 3600 4.0(6.1) device package incorporates the fix and may not work
properly with Cisco 3600 series routers running Cisco IOS versions below
011.001(007).

Card Support for Cisco 4000, 4500, and 4700 Series
The following network processor modules (npm) are supported:

• npm-4000-fddi-sas

• npm-4000-fddi-das

• npm-4000-1e

• npm-4000-1r

• npm-4000-2s

• npm-4000-2e1
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• npm-4000-2e

• npm-4000-2r1

• npm-4000-2r

• npm-4000-4t

• npm-4000-2t16s (for 4500 and 4700 routers only)

• npm-4000-4b

• npm-4000-8b

• npm-4000-ct1

• npm-4000-ce1

• npm-4000-1a

• npm-4000-6e

• npm-4000-1fe

• npm-4000-1hssi (for 4500 and 4700 routers only)

FDDI Port Status Functionality
For 4000 series routers running Cisco IOS Release 10.2 or earlier, the
displayed status color is determined from the port’s administrative status
(ifAdminStatus) and operational status (ifOperStatus) values. This status
color will be the same on each connector. For devices running Cisco IOS
Release 10.3 or later, the displayed status color is determined from the Port
Connect State (fddimibPORTConnectState) for each connector. The possible
values for this status and the corresponding status colors follow:
[CSCdi28566]

Status Status Color

disabled brown

standby brown

connecting blue

active green
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Notes and Caveats for High-End Business Products

Card Support for Cisco 7000 Series
The following interface processors and port adaptors are supported:

• cpu-7200-npe200

• vip2-50

• ct3ip - Phase II

• feip2 - tx/fx

• sa-encryption

• pa-oc3sm-mux-cbrt1

• pa-oc3sm-mux-cbr120e1

• pa-oc3sm-mux-cbr75e1

• pa-oc3mm-mux-cbrt1

• pa-oc3mm-mux-cbr120e1

• pa-oc3mm-mux-cbr75e1

• pa-ds3-mux-cbrt1

• pa-e3-mux-cbr120e1

• pa-jt2

• pa-4me1-bal

• pa-4me1-unbal

• pa-1e3

• pa-2e3

• pa-1t3

• pa-14e-switch
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Can't Read DD(port-23.port-26.pos) for Fast Ethernet PA
When you try to open a horizontal-chassis device such as the Cisco 7204,
7206, or 7505 with a Fast Ethernet port adapter installed, the error message
“can't read ‘DD(port-23.port-26.pos)’: no such element in array” is displayed.
To fix this, upgrade to the latest Cisco 7000 CiscoView package at
http://www.cisco.com/cgi-bin/tablebuild.pl/cview40. [CSCdj16247]

CT3IP Interface Processor Card
No MIB object is associated with the test port on a CT3IP card.
[CSCdj18638]

Displayed ATM Connector Type
CiscoView always displays the multimode fiber SC type of ATM connector
on AIPs, even when the media interface is of another type. [CSCdi53420]

DS3 Config-Monitor Items Missing from Dialog Boxes
For pa-1e3 and pa-1t3 cards, DS3 Configuration does not appear in the config
rport dialog box. Also, DS3 Current Statistics and DS3 Total Statistics do not
appear in the monitor rport dialog box. [CSCdj60001]

FDDI Port Status Functionality
For 7000/7500 series routers running Cisco IOS Release 10.2 or earlier, the
displayed status color is determined from the port’s administrative status
(ifAdminStatus) and operational status (ifOperStatus) values. This status
color will be the same on each connector. For devices running Cisco IOS
Release 10.3 or later, the displayed status color is determined from the Port
Connect State (fddimibPORTConnectState) for each connector. The possible
values for this status and the corresponding status colors follow.
[CSCdi28566]

Status Status Color

disabled brown

standby brown

connecting blue

active green
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FEIP2 Interface Processors
CiscoView displays an FEIP2-FX interface processor as an FEIP2-TX for all
Cisco IOS versions before Release 11.1(11)CA. [CSCdj15831]

FEIP-FX Card Not Displayed
The feip-fx card does not appear in CiscoView. When the Cisco 7000 series
device comes up, you might see the error message “no such element in array.”
[CSCdj61077]

LEDs Not Shown for FDDI Interface
For devices running Cisco IOS Release 10.2, a FIP card’s PhyA and PhyB
LEDs do not appear lit in CiscoView. [CSCdj23023]

Flash File System
When performing the Squeeze operation on a Flash card, the error message
“Failed to Squeeze. Try increasing the timeout property under Options in the
Main window” might be observed even though the operation succeeds.
[CSCdj03172]

High System Availability (HSA)
On the Cisco 7513 and Cisco 7507 chassis, when the master RSP (Route
Switch Processor) is in use, the console port changes color on the CiscoView
display. However, when a slave RSP is installed, its console port mirrors that
of the master, regardless of whether it is in use. [CSCdi49049]

Invalid Port Level FSIP Config Category
An invalid port level FSIP Config category will appear for devices with MIP
cards running Cisco IOS software earlier than Release 11.1. The dialog box
shows N/A for variables displayed in it, as these do not apply. [CSCdj23970]

Misidentified FastSerial Port Adapter
CiscoView might display a 4-port FastSerial port adapter (pa-4t) as a HSSI
adapter (pa-ah1t). [CSCdj17487, CSCdj17516]
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Wrong Polling Results After Hot Swap
After an online insertion/removal (OIR) event (also called a “hot-swap”),
CiscoView does not show the correct module or port status. The only way to
display the correct status is to reopen the device or relaunch CiscoView.
[CSCdj39860]

Unknown Enumeration
In the DS1 Configuration dialog, dsx1LoopbackConfig is reported with an
unknown enumeration. [CSCdj17466]

LightStream1010
Ensure you are using the latest LS1010 device package (version 1.8). You can
download this package from CCO. [CSCdj59465]

To configure an LECS address for LS1010 from CiscoView, ServiceId needs
to be the following: 10.1.3.6.1.4.1.353.1.5.1.<Index>, where Index is the row
differentiator for configuring multiple LECS addresses. Index is an integer.

From CiscoView for LS1010, the ATM Traffic Descriptor table does not show
any rows. This is an agent bug. [CSCdj00685]

Power Supply Display
By default, CiscoView displays two power supplies for a Cisco 7000 router
running Cisco IOS Release 10.2 or earlier. With Cisco IOS Release10.3 or
later, power supplies are displayed based on ciscoEnvMonSupplyState
values.

Notes and Caveats for Online Help

Find Tab
The creation of the full-text search database (Find option) in online help
might take several minutes, depending on the number of devices you have
installed.
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Because of the way a master CiscoView contents file is used by the software
when multiple CiscoView device package help files are present, the list of
files to include when setting up a customized find operation contains multiple
items, called CiscoView. [CSCdj62089]

Cisco 4000 Series Help Error
The Cisco 4000 Series help incorrectly states that they are stack devices.
There is also a link to the StackMaker help that does not work. To reach
StackMaker help, ensure the StackMaker help package is installed and select
Help>Contents to locate the StackMaker help topics. [CSCdj01872]

Obtaining Service and Support
For service and support for a product purchased from a reseller, contact the
reseller. Resellers offer a wide variety of Cisco service and support programs,
which are described in the section “Service and Support” in the information
packet that shipped with your chassis.

Note If you purchased your product from a reseller, you can access Cisco
Connection Online (CCO) as a guest. CCO is Cisco Systems’ primary,
real-time support channel.Your reseller offers programs that include direct
access to CCO’s services.

For service and support for a product purchased directly from Cisco, use
CCO.

Cisco Connection Online
Cisco Connection Online (CCO) is Cisco Systems’ primary, real-time support
channel. Maintenance customers and partners can self-register on CCO to
obtain additional information and services.

Available 24 hours a day, 7 days a week, CCO provides a wealth of standard
and value-added services to Cisco’s customers and business partners. CCO
services include product information, product documentation, software
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updates, release notes, technical tips, the Bug Navigator, configuration notes,
brochures, descriptions of service offerings, and download access to public
and authorized files.

CCO serves a wide variety of users through two interfaces that are updated
and enhanced simultaneously: a character-based version and a multimedia
version that resides on the World Wide Web (WWW). The character-based
CCO supports Zmodem, Kermit, Xmodem, FTP, and Internet e-mail, and it is
excellent for quick access to information over lower bandwidths. The WWW
version of CCO provides richly formatted documents with photographs,
figures, graphics, and video, as well as hyperlinks to related information.

You can access CCO in the following ways:

• WWW: http://www.cisco.com

• WWW: http://www-europe.cisco.com

• WWW: http://www-china.cisco.com

• Telnet: cco.cisco.com

• Modem: From North America, 408 526-8070; from Europe,
33 1 64 46 40 82. Use the following terminal settings: VT100 emulation;
databits: 8; parity: none; stop bits: 1; and connection rates up to 28.8 kbps.

For a copy of CCO’s Frequently Asked Questions (FAQ), contact
cco-help@cisco.com. For additional information, contact
cco-team@cisco.com.

Note If you are a network administrator and need personal technical
assistance with a Cisco product that is under warranty or covered by a
maintenance contract, contact Cisco’s Technical Assistance Center (TAC) at
800 553-2447, 408 526-7209, or tac@cisco.com. To obtain general
information about Cisco Systems, Cisco products, or upgrades, contact
800 553-6387, 408 526-7208, or cs-rep@cisco.com.

Cisco documentation and additional literature are available in a CD-ROM
package, which ships with your product. The Documentation CD-ROM, a
member of the Cisco Connection Family, is updated monthly. Therefore, it
might be more up to date than printed documentation. To order additional
copies of the Documentation CD-ROM, contact your local sales
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representative or call customer service. The CD-ROM package is available as
a single package or as an annual subscription. You can also access Cisco
documentation on the World Wide Web at http://www.cisco.com,
http://www-china.cisco.com, or http://www-europe.cisco.com.

If you are reading Cisco product documentation on the World Wide Web, you
can submit comments electronically. ClickFeedback in the toolbar, select
Documentation, and clickEnter the feedback form. After you complete the
form, clickSubmit to send it to Cisco. We appreciate your comments.

This document is to be used in conjunction with theOverview for CiscoWorks Windowspublication.
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